
Welcome to WebMaster MailRoom

So, you have a website and want more direct contact to your visitors.    You want to obtain more 

information about them, let’s say, in order to target your marketing efforts at them.    Perhaps you want to 

keep your customers up-to-date about your products and services.    Or maybe you want to bring news 

and information to people interested in a certain subject.

No matter which one of these scenarios describes you, what you need is a program that allows you to 

easily create extensive messages, while at the same time enabling you to conveniently manage a large 

address database.

WebMaster MailRoom unites these two functions in such as way as to make the management of 

extensive data a breeze, whether you are distributing newsletters, memos or targeted surveys, 

conducting letter or ad campaigns, or cold-mailing.

WebMaster MailRoom provides you with the easiest method of creating client databases for targeted 

marketing:    simply include a form on your website, with which to collect the desired address information 

and other data from your visitors.    The program then analyzes this data and sorts it automatically 

according to recipient lists set up by you (e.g. newsletter subscribers, contest participants, people 

interested in a certain product, etc.). 

If you want to give your mail merge messages an individualized look, you will find that WebMaster 

MailRoom provides you with far-reaching formatting possibilities, as well as with the option of integrating 

logos, images and tables.    Furthermore, you can personalize each message by inserting user fields 

containing all the data for the specific user.

Finally, if you have created your website with web to date by DATA BECKER, you now have the ideal 

productivity duo.    The two programs are guaranteed compatible, and the similar program interfaces make 

it easy to get used to and work with WebMaster MailRoom.

The DATA BECKER Team wishes you hours of mailing enjoyment with WebMaster MailRoom!



Inbox

The messages you receive in WebMaster MailRoom are mainly requests for the subscription/cancellation 

of subscriptions (e.g. for newsletters), notices of participation in contests, etc.    All of these messages, 

whether they announce subscriptions or requests for subscription cancellations, are listed in the Inbox 

area.    A new message is displayed in the Inbox as soon as it arrives, provided it fulfills the prerequisites 

for being received in WebMaster MailRoom (see below).

The automation process of WebMaster MailRoom starts at the same time.    The sender of the received 

message is added as a new recipient and assigned to an existing recipient group, if the program can 

identify an appropriate group for him/her. 

If the sender has contacted you via a form, the program recognizes the additional data from the form and 

assigns it to the new recipient together with the e-mail address.    Such additional data may include name, 

address, and phone number, but also personal interests.    The only prerequisite is that this data should 

have been entered in user-defined fields in the form.

Note:  If the sender hasn’t contacted you via a form but through a normal e-mail message, WebMaster 

MailRoom creates a new recipient record with the e-mail address and the assigned recipient group.    

You will then have to enter additional data (e.g. name, address, etc.) by hand under Recipient 

Properties. 

Working in the Inbox area 

1. All received message are listed in a table in the Inbox area.    The table contains four fields:    Sender, 

Type, Details and Date.    Click on one of these fields to change the order in which the messages are 

sorted according to this field.    To change the width of a column, place your cursor over the column 

division and move the cursor in the desired direction while keeping the mouse button depressed.

2. The listbox above the table allows you to filter the received messages according to established criteria. 

WebMaster MailRoom analyzes the format of each incoming message and assigns it different 

characteristics according to its type.    All messages are displayed by default.    The program 

differentiates between the following types of messages:

Message Type Meaning

Subscriptions via e-mail All messages regarding a request for subscription (e.g. to a 

newsletter) which were sent via an e-mail program.

Cancellations via e-mail All messages regarding the cancellation of a subscription (e.g. to 

a newsletter) which were sent via an e-mail program.

Subscriptions via form All messages regarding a request for a subscription (e.g. to a 

newsletter) which were sent via a form.

Cancellations via form All messages regarding the cancellation of a subscription (e.g. to 

a newsletter) which were sent via a form.

Error All messages where the category is unclear or faulty are 

classified under this type.    They can include:

- Requests where the sender of the message has not included an 



e-mail address

- Requests from recipients on the Blacklist

- Subscriptions/Subscription cancellation requests regarding a 

faulty subscription (e.g. because of a typo)

Unknown e-mail If messages which do not fulfill the prerequisites for being 

received through WebMaster MailRoom (see below) reach your 

e-mail server, they are interpreted as "unknown e-mails".    These 

messages do appear in the Inbox as having arrived, but rather 

the program leaves them on the server, so you can receive them 

in your regular e-mail program.    You cannot read or edit these 

messages in WebMaster MailRoom.

3. Above the table, you will also find the following buttons.    Select a message in the table and click

Ÿ on  to view the message properties of the selected message, 

Ÿ on  to delete the selected message,

Ÿ on  to view the sender's properties,

Ÿ on  to check if you have new messages on the server.

Note:    Because all recipient data is automatically interpreted and managed by WebMaster MailRoom 

when a message arrives, you can delete your messages immediately, for the information has already 

been processed.    We only recommend keeping a message if you want proof of having received an entry 

or a subscription or cancellation request. 

Prerequisites for receiving messages in WebMaster MailRoom

For an incoming mail to be correctly identified, received and analyzed by WebMaster MailRoom, it must 

have a valid e-mail address and a subject which the program can interpret.    This means that the 

entry in the subject line—with which your client subscribes or unsubscribes to a newsletter, for instance—

is predetermined.

If the subscribe/unsubscribe requests comes in an e-mail created through an online form on your 

website, you don’t have to worry about the subject, since it is generated automatically ("formsubscribe" or 

"formunsubscribe").    If you want to make it possible for your clients to subscribe/unsubscribe through 

regular e-mail, however, you must let them know what they should fill into the subject line.    There are 

three commands at your disposal for each kind of request, followed by the corresponding subscription 

abbreviation.    This is the abbreviation you defined when you created your subscriber or recipient 

group.

The subject line must fulfill the following requirements:

Request Subject Line Entry

Subscription: subscribe subscription abbreviation

add subscription abbreviation

+ subscription abbreviation

HTML subscription: subscribe subscription abbreviation html



add subscription abbreviation html

+ subscription abbreviation html

Subscription cancellation: unsubscribe subscription abbreviation

remove subscription abbreviation

- subscription abbreviation

Subscription to all/Cancellation of all: subscribe all / unsubscribe all

add all / remove all

+ all / - all

Note:    We recommend encouraging subscriptions/cancellations of subscriptions via an online form, 

since here the subject entry is generated behind the scenes.    In actuality, e-mailing usually only occurs 

when there are cancellations of existing subscriptions.



Outbox

Once you have created a new mail merge message under Mail Merge Messages and have clicked on 

the Send mail merge message button , the message is deposited in the Outbox.    Here, you can view 

it again and delete it if necessary, or finally send it to the mail server and your recipients. 

Note:    You can forego the temporary sending of your messages to the Outbox by changing the user 

settings in the Send options.    Then, clicking on the  button sends the messages directly to the mail 
server.    This means, of course, that you have no further chance of reviewing your message and 
reversing the sending command.

Working in the Outbox area 

1. All messages to be sent are listed in a table in the Outbox area.    The table contains three fields:    

Recipient, Subject and Created on.    Click on one of these fields to change the order in which the 

messages are sorted according to that field.    To change the width of a column, place your cursor over 

the column division and move the cursor in the desired direction while keeping the mouse button 

depressed.

2. Above the table, you will see three buttons.    Select a message in the table and click 

Ÿ on  to Show message,

Ÿ on  to delete the selected message,

Ÿ on  to send all messages in the Inbox to the e-mail server and their recipients.

Tip:    To select multiple e-mails, use the arrow keys, while keeping the [Shift] key depressed.



Sent messages

Once you have successfully sent one or several messages from the Outbox, they appear in the Sent 

Messages area.    The functions available to you here correspond to those in the Outbox area.

Working in the Sent Messages area 

1. All sent messages are listed in a table in the Sent Messages area.    The table contains four fields:    

Recipient, Subject, Created on and Sent.    Click on one of these fields to change the order in which 

the messages are sorted according to that field.    To change the width of a column, place your cursor 

over the column division and move the cursor in the desired direction while keeping the mouse button 

depressed.

2. Above the table, you will find three buttons.    Select a message in the table and click 

Ÿ on  to Show message,

Ÿ on  to delete a selected message,

Ÿ on  to move an already sent message back to the Outbox in order to send it out again.

Tip:    To select multiple e-mails, use the arrow keys, while keeping the [Shift] key depressed.



Transfer errors

If the messages in the Outbox could not be sent for whatever reason, they are not placed in the Sent 

Messages box, but are moved into the Transfer Errors folder.    The functions available to you in this 

area correspond for the most part to those in the Outbox area.

Working in the Transfer Errors area 

1. All messages which could not be sent are listed in a table in the Transfer Errors area.    The table 

contains four columns:    Recipient, Subject, Created on and Send attempt.    Click on one of these 

fields to change the order in which the messages are sorted according to that field.    To change the 

width of a column, place your cursor over the column division and move the cursor in the desired 

direction while keeping the mouse button depressed.

2. Above the table, you will find three buttons.    Select a message in the table and click

Ÿ on  to Show message,

Ÿ on  to delete the selected message,

Ÿ on  to move an already sent message back to the Outbox in order to send it out again.

Tip:    To select multiple e-mails, use the arrow keys, while keeping the [Shift] key depressed.



Recipients

Usually, all your client records belong to one or several groups.    For instance, if you offer a newsletter 

with news about your company, all subscribers can be part of the "Company newsletter" group.    

Participants in a contest can be in a different recipient group.    Each recipient can be included in several 

groups simultaneously, however.    After all, it is very possible that a newsletter subscriber also wants to 

take part in your contest. 

Because WebMaster MailRoom is capable of reading and analyzing recipient information from incoming 

messages, the program creates a new recipient record containing all properties it is able to interpret for 

each message sent through an online form created with web to date or for each e-mail subscription.    

The program also simultaneously assigns the recipient to a predefined group.    If the recipient sends you 

a request for cancellation, the record is automatically removed from the assigned group.

In the Recipients area, you can gain an easy overview of the size and composition of each group.    You 

can select any recipient in the table and edit his or her properties.    You can also add new recipients to 

the group or move existing recipients, as well as expand the list of user-defined fields with which you 

ask for your client’s data in your online form.

To find out how to create a new group, go to Group Properties. 

Working in the Recipients area

Whether you have selected a group you have created yourself or one of the predefined groups, like All 

recipients or Blacklist:    the view that is presented to you in this area differs only in the names of the 

group members listed in the table.

1. From the folder list, select the group you want to view. 

2. The table shows you all recipients belonging to this group, e.g. the subscribers to a particular mailing 

list.    The table fields correspond to the user-defined fields and are identical to the text entry fields in 

the online form you created with web to date.    To change the order in which the entries are sorted, 

click on one of the column heads.    This is helpful particularly with extensive recipient lists.

3. Use the buttons in the toolbar for the following commands:

Icon Command Meaning

              Recipient properties Opens the properties of the recipient 

selected in the list.

Delete recipient Deletes the recipient selected in the list.    

Beware!    If this recipient also appears in 

another group, he or she will be deleted from 

there as well.    To delete the recipient only 

from the current group, use the Group 

assignment or right-click to open the 

context sensitive menu and select the 

command Delete Recipient from this 

Group.



New recipient Opens the dialog window New Recipient 

and adds a new recipient to the group.

User-defined fields Opens the dialog window User-defined 

Fields, where you can create and edit form 

fields.

Group properties Opens the Properties of the current group.

Delete group Deletes the current group in its entirety.

Show messages to this 

group

Switches to the mail merge message 

functions and displays all mail merge 

messages assigned to the current recipient 

group.

Group assignment Opens the Group Assignment dialog 

window, where you can change the group 

assignment of the selected recipient.



The Recipients and Groups function group

WebMaster MailRoom manages all recipient data in the Recipients and Groups function group.      This 

data includes the name and e-mail addresses of your subscribers, as well as all information provided 

through the user fields of an online form created with web to date and included on your website.    Yet 

the Recipients and Groups function group is more than just a collection of data:    by defining individual 

user groups according to certain themes and assigning each recipient record to one or several of these 

groups, you build a database of recipients sorted by interests and themes, which you can expand at any 

time.    At the same time, you can exclude individual recipients from receiving messages by placing them 

on the Blacklist, if they have informed you that they don’t want to receive any further messages from 

you.    Thus, the targeted marketing possibilities made available by WebMaster MailRoom are quite 

considerable.

If you requested the creation of sample groups when you opened a new project with the WebMaster 

MailRoom Start Wizard, you will find the empty sample groups "Standard" and "Premium" in this area.

In the Recipients and Groups function group, you can also define the properties for each individual 

recipient, i.e. you can specify not only the cases in which your clients should be contacted, but also the 

mailing format in which this should be done, the form of address for each client, etc. 

Note:    WebMaster MailRoom pretty much creates new newsletter recipients for you:    the automation 

process of the program starts immediately after the receipt of a subscription request.    The message is 

analyzed, and a new recipient record is created from the extracted data and assigned to a user group.    If 

you want to create user groups that are not automatically composed from subscriber data (e.g. for 

extensive mailing and cold-mailing processes), you can import recipient and client data from other 

databases or address books into WebMaster MailRoom by using the import function. 

Click here to find out more about receiving messages in WebMaster MailRoom.

Recipient and Groups area functions

The Recipients and Groups area offers you all the important functions you need to create recipient or 

user groups in an easy overview.    As an alternative, you can also use the icons in the toolbar of the work 

area.    You can recognize commands that refer to recipients by the symbol , and commands that refer 

to recipient groups by the symbol 

.

1. New recipients and groups

Click on the entry Add a new recipient or on the  button to create a new recipient record.    Click on 

the entry Create a new group or on the 

 button to create a new recipient group.    A newly created group appears in the table below containing 
an overview of all groups.
2. Editing recipients and groups
In order to see which recipients have been assigned to a group or in order to edit the properties of 
individual group members, you must first open the group in the work area.    You can do so over the folder 
list on the left or by switching groups in the table displayed in the work area.    The table displays not only 
the user groups you created, but also all unassigned recipients, as well as all those recipients who have 
requested to be dropped from a mailing list ("Blacklist"). 

Recipients Contains all entries assigned to the corresponding recipient group.

(The number and names of the groups appear according to your input).



(All recipients) Offers the complete list of recipients assigned to the different recipient lists.

(Not assigned) Contains recipient entries not assigned to any recipient list.

(Blacklist) Contains recipients who have requested that no more mail be sent to them.

To open a group, double-click on its entry.

The following commands are available over the buttons at the bottom of the table (or in the toolbar of 

the work area):

Delete group Deletes the recipient list selected in the table.

Properties Opens the Properties of the recipient group selected in the table.

Show messages Switches you to the Mail Merge Message function group and 

displays all mail merge messages assigned to the selected recipient 

group.

Creating new recipient databases

There are two ways in which to create recipient databases: 

1. Automatic recipient creation:    The automatic set-up of recipients usually happens without you 

noticing and is based on the ability of WebMaster MailRoom to analyze the data contained in incoming 

messages.    The recipients are then automatically assigned to a group, to which their data records are 

sent.    The requirement for this process is that the recipient be requesting a subscription (e.g. to your 

newsletter) via an order form or an e-mail message.

2. Manual recipient creation:    In all other cases, you need to set up the recipient manually using the 

 button.    You may have to do this, for instance, if you want to use the mail merge function in 

WebMaster MailRoom to write to an outside user circle (e.g. to offer your services to potential clients). 

The import function of WebMaster MailRoom allows you to import existing address books or contact 

lists into WebMaster MailRoom out of other applications.



Editing messages

The actual creation of mail merge messages happens in the Edit Message area.    Click in the message 

field with the mouse, then type in the text of your message.

There are two main message formats, each with its own formatting possibilities:

Ÿ Messages in HTML format: 

This format offers you extensive options for formatting your messages.    In addition to bolding and 

italicizing, you can freely define the font and font size, change the font and background colors, adjust 

the alignment of the text and even insert tables.    In HTML, you may also insert images. 

Ÿ Messages in plain text format:

The plain text format offers only limited formatting possibilities.    The extensive formatting leeway 

afforded by HTML does not exist here.

Because not all e-mail clients can correctly receive HTML messages, the question of the format in which 

you create your message mainly depends on the format which your recipient can read.    Because you 

don’t know that, you should request this information through your order form and store it in the recipient 

properties.

How to create and edit messages in HTML format 

1. Open the message editing work area by either creating a new mail merge message or clicking on an 

existing one.    Make sure that you are in HTML format.    You can recognize this by the fact that the 

HTML button  underneath the work area is depressed.

2. Type in the text of the message or edit the existing text.    If you have already created your 
message in another application (e.g. in Word), you can copy this text into the current message by going to 
Mail Merge/Import Mail Merge Message (you will lose images through this process, however).

Note:    All the commands used below can also be executed by selecting the corresponding entries in 

the Format menu or from the context sensitive menu (which opens when you right-click).

3. Select the font and font size from the listbox in the toolbar of the work area.    When you select the font, 

bear in mind that the recipient must also have it on his/her computer, even if he/she can receive HTML 

messages.    To make sure that the message really looks the way you intend it to, you should only use 

the most common fonts, e.g. Arial, Times New Roman or Tahoma.    It is for this reason that the choice 

of fonts in WebMaster MailRoom is limited.

4. Format the text according to your wishes.    The following options are available for formatting HTML 

messages:

Italicizes the selected section or word.

The selected section or word appears in bold.

Opens the Color [T.N. Did not come across this in the resources] dialog window, where you can 
assign another color to the selected section or word.

Left aligns the selected section.

Centers the selected section.

Right aligns the selected section.

Justifies the selected section.

5. In HTML format, you can also insert the following additional elements, in order to make the mail merge 



message more interesting for your recipients: 

Inserts a table into your HTML message.

Increases the width of the column where the cursor is located.

Decreases the width of the column where the cursor is located.

Inserts a user field into your message.    Select the desired field from the list of decision fields. 

Opens the Insert External Link dialog window, where you can link individual words to Internet or 
WWW addresses.

Opens the Insert Image dialog window, where you can insert images as image files into your mail 
merge message.

6. If you have incorporated user or decision fields into your message, they are first only represented as 

placeholders in the work area.    To check how the field content looks for the different recipients, you 

should view the whole message in the send preview.      To preview your message, either click on the 

 button in the toolbar or on Preview in the following dialog window.

7. To send your mail merge message, click on the Send mail merge message button .    In the 
next dialog window, you can change the mail merge message properties one more time; then, click on 
the Send button to send the message to the Outbox.

8. To view or edit the mail merge message properties, click on the  button.

9. Do white backgrounds bore you?    You can select a different background color for your HTML 
message by choosing the Background Color command from the Format menu.    Pick a new 
background color from the Color dialog window and confirm your choice by clicking on OK. 
10. Also in the Format menu, you can create decision fields and text blocksIDH_DIALOG_PHRASES 
and insert file attachments.

How to create and edit messages in text format

To create a mail merge message in plain text, you need to enable the Text  button in the work area of a 

new message.    All formatting possibilities are then unavailable, and the number of available commands 

is restricted to the following buttons: Mail merge message properties 

, Send mail merge message 

, Send preview 

 and Insert user field 

. 

With the help of the Format menu, you can create additional decision fields and text 

blocksIDH_DIALOG_PHRASES for your text message, as well as insert file attachments.

How to copy a message from one format into the other

If you have already created your message in one of the two formats, you can copy it into the other one 

without any trouble, simply by clicking on the Copy  button.    Please note that formatting done in HTML 

will be lost when copying into text format.

We recommend that you check the copy result at all times.    Textual references to images make sense in 

an HTML message but not in a text message.



The Mail Merge Messages function group

The Mail Merge Messages function group is the WebMaster MailRoom area in which you compose and 

manage messages in order to send them to the desired recipient groups.    The most usual mail merge 

form is the newsletter, but you can compose any kind of message in the Mail Merge Messages area. 

Basically, you should compose any message which you want to send to several recipients without 

changing the basic text but with the addition of user-specific content as a mail merge message in 

WebMaster MailRoom.    This will save you a lot of time as compared to a normal e-mail program.

In WebMaster MailRoom, you have two different possibilities of customizing your mail merge messages:

Ÿ by inserting user fields,

Ÿ by inserting decision fields  .  

Note:    Mail merge messages must always be assigned to one or several recipient groups; otherwise, you 

can't send the messages because you are lacking recipient information.

All processes of creating and editing a message are carried out in the Mail Merge Messages area.

Working in the Mail Merge Messages area

1. Open the Mail Merge Messages area in the work area by selecting Mail Merge Messages from the 

folder list or by clicking on the  button in the toolbar.    An overview of all important actions appears 

in the work area.

2. To create a new mail merge message, click on the Create a new message entry or on the  
button in the work area toolbar.    A dialog window opens, in which you can adjust the Mail Merge 
Message Properties. 

3. In the table in the work area, WebMaster MailRoom shows you all messages you have already 

composed by default.    If you have already sent one of these messages, the date it was mailed out is 

also displayed.    To open a message (e.g. to edit it further), double-click on its entry.    The desired 

message is then displayed in the work area.

4. You can delete a mail merge message by clicking on an entry in the table to select it then clicking on 

Delete message or the button .    You are then prompted to confirm the decision, after which the 

message is removed from the program.

Note:    To delete several messages simultaneously, keep the [Shift] key depressed and use the arrow 

keys to select any number of messages.

5. To view and edit the properties of the selected message, click on the desired message then on 

Properties or the  button in the work area toolbar.

6. For an overview of the messages assigned to individual recipient groups, filter the messages by 
selecting the desired group from the listbox in the work area toolbar.    In this listbox, you can also choose 
to view all unassigned messages (e.g. so you can assign them to one or several groups).



The Sending and Receiving function group

The Sending and Receiving function group gives you access to all processes related to the sending and 

receiving of messages (e.g. mailing, sending newsletters, receiving subscriptions, etc.). 

The Sending and Receiving area gives you an overview of your current mailing situation.    In addition, it 

provides you with easy access to all subordinate folders, as well as to the most important mailing 

functions.    You can reach this area by clicking on the  button in the program toolbar or by selecting it 

from the folder list on the left. 

Accessing the Sending and Receiving folders

There are three possibilities for opening individual folders in the Sending and Receiving function group:

1. By clicking on a folder in the folder list on the right side of the main WebMaster MailRoom window

2. By clicking on the corresponding icons at the top of the Sending and Receiving area

3. By clicking on the corresponding entries within the Sending and Receiving area

The Sending and Receiving function group contains the following folders:

Icon Folder Meaning

Inbox Lists all received messages. 

Outbox Lists all messages to be sent.

Sent Messages Lists all messages which have already 

been sent.

Transfer Errors Lists all messages which have been sent 

incorrectly because of problems (e.g. 

wrong e-mail address).

Images Used Lists all images you have inserted into your 

mail merge messages.

Accessing the Sending and Receiving function group transfer processes 

The Sending and Receiving area gives you direct access to the most important data transfer processes. 

These processes are available under Transfer, or over the corresponding icons above the work area. 

Icon Transfer process Meaning

Send Outbox Click on this icon to mail messages from 

the Outbox.

Query Inbox Click on this icon to check whether there 

are new messages in the Inbox.

Publish image files Click on this icon to publish the image files 

you use in your messages.



Start screen

The program starts with the main window of WebMaster MailRoom.    This window is composed of a folder 

list on the left and a larger work area on the right.    The display in the work area depends on the specific 

group of functions you have selected from the folder list.

The start screen of the work area offers you quick overview and access to the three main function groups 

of the program.    In the folder list, it opens with the top level of the folder hierarchy (represented by the  

icon).

1. Sending and receiving messages 

The Sending and Receiving function group informs you about the message traffic through the Inbox, 

Outbox or the Sent Messages.    To access this function group, click on the Switch to Sending and 

Receiving text entry or on the  button above the work area.

If you want to check for new messages as soon as you start the program, click on the Check the 

Inbox for new subscriptions text entry or on the  button.

2. Mail merge messages

The Mail Merge Messages function group is the designated WebMaster MailRoom area for creating 

and editing messages (e.g. newsletters, advertising mails, etc.).    To reach it, click on the Switch to 

Mail Merge Message overview text entry or on the  button above the work area.    To compose a 

new mail merge message, click on Create a new mail merge message or on the 

 button.
3. Recipients and groups
For every WebMaster MailRoom project, you can create and manage different recipient groups for 
different mail merge messages.    You can input specific information for each recipient under Recipients 
and Groups .    To reach this area, click on the Switch to Recipients and Groups overview text entry or 

on the     button.    To create new recipients and groups, click on Create a new recipient or group or 
on the 

 button.

You can reach these three function groups over either the program toolbar or the folder list.

The link in the bottom right-hand corner of the screen takes you to the website of WebMaster MailRoom.

You can return to the start screen while the program is running by clicking on the Start  button. 



Images used in messages

When you send a mail merge message containing images to the Outbox, the image files are routed to a 

different area – the folder Images Used.    Images are handled differently because they are not mailed out 

over the e-mail server like normal messages but are stored on your web server.    When the recipient 

opens his/her mail, the e-mail client automatically downloads the image.    Thus, the Images Used fulfills 

two roles:    first, it gives you an overview of all the images you have used; second, it allows you to 

exclude individual images from being sent or even to delete them before a data transfer has occurred.

Note:  If you want to send messages containing images, don't forget that you have to send the message 

and the image file separately!    While the message is sent from the Outbox to the e-mail server and from 

there directly to the recipient, images are transferred to the web server from the Images Used folder.    For 

such messages, it makes sense to first transfer the images and only then send the messages, so the 

recipient can download the image file from the web server as soon as he/she has received the message. 

Working in the Images Used  area

1. All images contained in messages are listed in a table in the Images Used area.    The table contains 

the fields File name and WWW address, which shows you the path under which the file is or should 

be saved.    Click on either of these fields to change the order in which the image files are sorted.    To 

change the size of the column, set the mouse above the dividing line and drag it in the desired 

direction while keeping the mouse button depressed.

2. Unlike in other areas of the Sending and Receiving area group of functions, here, you will find an 

additional information window underneath the table.    Clicking on one of the individual table entries 

displays not only detailed information about the file, but also a preview of the image.    After all, image 

file names are not always obvious. 

3. Above the table, four buttons offer you the following functions:

Marks the selected image as ready to be published.    The image will then be sent to the web 
server during the next data transfer.

Marks the selected image as already published.    The image will then be excluded from being 
sent to the web server during the next FTP transfer.

Deletes the selected image.    If the image was already sent to the server, this doesn't change 
anything, of course.    Otherwise, this image becomes inaccessible to the recipient. 

Starts the uploading process during which all selected image files are transferred to the web 
server.    You can recognize selected files by the icon 

.

4. To delete an image from the web server, you need to access it directly over an FTP program and 

delete it there.    You should leave images on the server for an extended period of time, however, 

because once you delete the file on the server the recipient cannot open it anymore.    Recipients who 

have been on holidays, for instance, would only find a placeholder instead of an image.



Field properties

As soon as you create a new user-defined field or start editing a an existing one, you are asked to 

determine its Field Properties in a dialog window.    There are two field properties you can define:

Ÿ Field name:    This is the designation under which the field is saved and displayed in forms.    You can 

incorporate the data you collect from this field into your mail merge messages to customize them 

according to your target audience. 

Ÿ Field abbreviation:  It is important that you define an abbreviation, so that the personal information 

which the recipient enters into the field as it appears in a web form can be transferred to WebMaster 

MailRoom.    If you are not using a web form, you also don't need to enter an abbreviation.



Creating user-defined fields

In the User-defined Fields dialog window, you define the fields that you want to make available for your 

WebMaster MailRoom project.    The function of user-defined fields is to collect information about the 

recipient.    In addition to the collecting of information about your clients, which you can use to target your 

marketing efforts more directly towards them, you can also incorporate this information into your mail 

merge messages in order to customize them for your clients. 

Click here to find out more about inserting user fields into mail merge messages. 

The user fields are usually the same fields that your clients and other interested parties have to fill out in 

your order form on your website.    Common fields include salutation, first name, last name, address, city, 

zip code and phone number.    However, you can also find out more detailed information, such as 

occupation and interests, using these fields.    The type and number of user fields depends on what kind 

of information you want to collect about your clients, i.e. on the purpose and extent of your targeted 

marketing efforts.

In order for WebMaster MailRoom to read the data that you collect from your recipients with the help of 

the order form correctly and to transfer it to the automatically created recipient record, it is important for 

the user fields to correspond with those in the web form.

Note:  You create the fields for every WebMaster MailRoom project only once.    Which user fields are 

taken into account for individual user groups- whether only a few or all - however, depends on the fields 

you integrate into your order form. 

Working in the User-defined Fields dialog window

1. Open the User-defined Fields dialog window for a recipient group by clicking on the  button or by 

selecting the User-defined Fields command from the Recipients and Groups menu.

2. The table which opens displays all fields you have already created or which WebMaster 
MailRoom has created for you when you started a new project.    You will find the name of the field next to 

the user field icon ; next to it is the corresponding abbreviation (if applicable), which connects the field 
to your order form. 

3. Click on the New field button to create a new user field and define its field properties.

4. Click on Edit to open the Field Properties of the field selected in the table in order to edit them.

5. Click on the Delete button to irreversibly remove the field selected in the table from your WebMaster 

MailRoom project.

6. The buttons Move up and Move down move the selected field one row up or one row down in the 

table.

7. Confirm your changes by clicking on the Apply button. 



Recipient properties

The dialog window Recipient Properties always appears when you create a new recipient or when you 

want to edit existing recipient information.    WebMaster MailRoom has the ability to analyze incoming 

messages and read recipient information, so the program creates a new recipient record containing all 

properties it can interpret whenever you receive a message through an online form created with 

WebMaster MailRoom or a simple e-mail request.

How to create a new recipient of edit existing recipient data

1. From the folder list, select Recipients and Groups and click on the Add a new recipient text link in 

the work area or on the corresponding button .    As an alternative, you can also select the New 

Recipient command from the Recipients and Groups menu.    The Recipient Properties dialog 

window opens.

2. Enter the correct e-mail address of the recipient in the properties field under E-mail or change 
existing names.

3. Under User fields enter the corresponding information, if known.    The Salutation, First name and 

Last name fields are created by default; you can create additional fields as user-defined fields.

4. Enable the control box under Blacklist if you don't want to send any more messages to this e-mail 

address.    The record is then saved under the Blacklist group.

5. Assign a subscriber list to the recipient by enabling the control box next to the group.    You can assign 

one or several subscriber lists to each recipient.    If you don't enable any group, no messages are sent 

to the recipient and he/she is saved under the Not assigned group. 

Note:    The automation process of WebMaster MailRoom ensures that the record is automatically 

removed from the assigned group(s) when the recipient cancels his/her subscription.

6. Under Format, decide whether the recipient should receive HTML or text mail merge messages.    If 

you have asked your subscriber how he/she wants to receive messages in an online form, the 

information is stored automatically.

7. Confirm your entries with OK.    If you want to create an additional recipient, click on the OK and new 

button.



User settings for the e-mail server

The most important prerequisite for problem-free data traffic (receiving subscription requests and sending 

out mail merge messages) is correct user information.    Only when these settings are correct can you 

communicate with your e-mail and web servers.

To ensure the correct transfer of mails, go to the File menu and select the command User Settings, then 

click on E-mail Server. 

The User Settings opens.    Click on the E-mail server tab and enter the correct information in the 

following fields. 

Sender's e-mail: Enter here the e-mail address that you want to display for your recipients (e.g. 

clients).    This is usually your e-mail address or that of your company.

Sender (name): Enter here the name that you want to display for your recipients or clients.    In 

addition to your name or that of your company, it may also contain a short 

description, such as "newsletter".

Incoming (POP3): Enter here your POP3 address or that of your incoming mail server.    You can 

obtain this information from your provider or server administrator.

Account name (POP3): Enter here the name of the POP3 mail account on your incoming mail server.    

You can request the provider or server administrator to set up this account for 

you and provide you with the relevant information.

Password (POP3): Enter here the password for your POP3 account.    You may have received it 

from your provider or defined it yourself.    For security reasons, the password is 

displayed as stars (*) on the screen.

Outgoing (SMTP): Enter here your SMTP address or the address of your outgoing mail server.    

You can obtain this information from your provider or server administrator.

If your SMTP outgoing mail server requires you to log in, which is often the case, you need to enable the 

corresponding control box underneath the data entry fields and enter the SMTP account name and its 

password.    Otherwise, you won't be able to send your WebMaster MailRoom messages.    Click on the 

Use POP3 login button to automatically apply the above POP3 information.

Confirm the settings by clicking on OK.

You can also open the user settings when you are in a mail merge message, i.e. when you have opened 

a mail merge message in the work area.    To do so, click on the Send mail merge message  button or 

on Send preview 

 and on Send options in the dialog window that opens.    There, go once again to the E-mail server 
tab. 



User settings for the web server

The most important prerequisite for problem-free data traffic (receiving subscription requests and sending 

out mail merge messages) is correct user information.    Only when these settings are correct can you 

communicate with your e-mail and web servers. 

If you have inserted images into your mail merge messages, the images are not mailed out to every 

recipient separately, but are uploaded to your web server only once.    This saves mailing time and costs, 

for the image information is not received by your clients directly (i.e. in the received messages), but is 

called up over a connection to the web server.    When your clients receive your message, their e-mail 

program automatically downloads your image files from the web server. 

To ensure the correct transfer (upload) of image data to your web server, select the User Settings 

command from the File menu and go to Web Server. 

In the User Settings dialog window that opens, go to the Web server tab and fill in the correct 

information in the following data entry fields. 

WWW address: Enter here the WWW address where your website is located on the web server 

(e.g. "www.yourwebsite.com").    If you want to save your image files in a 

specific directory, expand the address to include the directory (e.g. 

"www.yourwebsite.com/images").    Also enter the name of the directory under 

"FTP default directory" (see below).

FTP server: Enter the name of your FTP server.    You can obtain this information from your 

provider or server administrator.

FTP username: Enter here the login name for the FTP server.    You can obtain this information 

from your provider or server administrator.

FTP password: Enter here the password for your FTP server.    You may have received the 

password from the provider or defined it yourself.    For security reasons, the 

password is displayed as stars (*) on the screen.

FTP default directory: The FTP start directory is the directory in which you want to store the images on 

your server.    If you have entered your URL as your WWW address (e.g. 

"www.yourwebsite.com"), you can leave this field empty, for in this case you 

have not defined your own directory.    If, on the other hand, you have created a 

special folder on your web server (e.g. "www.yourwebsite.com/images"), you 

need to enter the name of the folder here (e.g. "images").    For WebMaster 

MailRoom image files you don't usually need to create your own directory.

Enable the control box under Do not use PASV to prevent passive data transfer (PASV).    This may 

happen when you have problems transferring data with this transfer mode (e.g. satellite Internet 

connections).    Generally, however, you should disable the control box.

Close the dialog window by clicking on OK.

Advanced firewall / proxy settings

If in addition to the FTP settings, you also want to set up a proxy server, click on the Advanced firewall / 



proxy settings button.    In the Firewall/ Proxy Settings dialog window, select the type of firewall you 

use from the listbox, fill out the data entry fields with information about the Server, Port, Username and 

Password for the firewall, then confirm your settings with OK.

Note:  Please be aware that these settings are not the norm.    Usually, you can skip the settings for the 

proxy server or firewall.    For more information on proxy servers and firewalls, contact your provider.

You can also open the user settings when you are in a mail merge message, i.e. when you have opened 

a mail merge message in the work area.    To do so, click on the Send mail merge message  button or 

on Send preview 

 and on Send options in the dialog window that opens.    There, go once again to the Web server tab.



User settings send options

On the Send options tab, you can determine how the finished messages will be transferred from the 

Outbox to your e-mail server.    You can get to the send options either by using the User Settings entry in 

the File menu or, if you currently have a mail merge message open in the work area, by clicking on the 

Send mail merge message button  or the Send preview button 

, and afterwards clicking on Send options.    You can enable the following control boxes to change the 
send options:

Send Outbox contents automatically: 

When you select this option, the messages to be sent will leave the Outbox immediately and be 

transferred to your e-mail server.    If you don’t select this option, the messages will collect in the Outbox 

and need to be sent manually.    In the last case, it is still possible to check the messages and edit them 

prior to sending.

Publish images automatically: 

When you select this option, any images that are accompanying your mail merge messages will be 

published immediately, meaning they will be transferred to the web server.    If you don’t select this option, 

the messages will first be collected under Images Used and need to be sent manually.

Send a maximum of xxx per sending session:

If you’ve selected this option, you can limit the number of e-mails that should be sent to the e-mail server. 

Use the spinbox or directly enter the number of messages that should be sent per sending session.    

Such a limit is recommended if the amount of e-mail activity is intense, so the burden on the computer 

and the server is kept to a minimum.

Do not send before xxx:

WebMaster MailRoom gives you the option of delaying the sending of messages.    You have the option of 

entering a time, according to the clock, for sending the messages, so that your computer is less burdened 

(e.g. at night).    The requirement for this, however, is that an Internet connection is present at that time.    

To do this, enable the control box and enter the corresponding time in the spinbox.

Confirm your choices by clicking on OK.



Mail merge message properties

As soon as you want to create a new mail merge message, you will be asked via a dialog window to 

establish its properties.    For existing messages, you can change the properties afterwards at any time, 

using this same dialog window.

How to create a new mail merge message

1. Go to Mail Merge Messages in the folder list and, in the work area, click on the Create a new 

message text link, or on the corresponding button .    Alternatively, you can go to the Mail Merge 

menu and select the entry New Mail Merge Message.    The corresponding dialog window will open.

2. In the Subject text box, enter a description that should appear for the recipient in the subject line, 
such as "Newsletter".

3. In the field underneath, To recipients of, you have to determine which subscription groups the 

message should be assigned to, meaning, which recipients should receive the e-mail.    In the list that 

contains all the groups you have created, check the control boxes of the corresponding recipient 

groups.    If you don’t select any groups, i.e. don’t assign any recipients, you cannot send the 

message later on.

4. If you determine while you are trying to assign groups that the desired recipient group has not yet been 

created, you can open the dialog window for creating new groups and determining the group 

properties by clicking on the button Create new group.

5. By enabling the lower control box, Use the Design Wizard, you can indicate whether you want to use 

a special header or an HTML layout for the new mail merge message from the start, and therefore 

open the Design Wizard.    Otherwise, disable the control box.

6. Confirm your entries with OK.

How to change the properties of an existing message

1. Go to the message whose properties you want to change, and click on the  button to show the 

properties of the mail merge message.    The corresponding dialog window will open.    The window will 

contain the settings you last specified.

2. Change the settings as described above and then click on OK.



Group properties

The dialog window Group Properties appears either when you create a new recipient group or when you 

want to edit an existing one.

How to create a new group or change the properties of an existing group

1. Go to Recipients and Groups in the folder list and, in the work area, click on the Create a new group 

entry or on the corresponding button, .    Alternatively, you can also go to the Recipients and 

Groups menu and select the New Group entry.    The Group Properties window will open.

2. For the Name, enter a name for the new group or rename an existing group.
3. For the Abbreviation, specify an abbreviation for the new group or change the existing one.    
Entering a field abbreviation determines the assignment of incoming e-mails from prospective 
subscribers, and is always necessary for newsletter recipient groups who cancel or subscribe via an 
online form or by e-mail.

4. Confirm your entries with OK.



Message preview

If you want to include user or decision fields in your mail merge message, they will only at first appear 

as placeholders in the work area.    By opening the Message Preview dialog window, you can verify if the 

field content results are correct for the various recipients.    The various field types will no longer be shown 

as placeholders, but with their actual, individual content.

How to use the Message Preview window

1. Call up the Message Preview window by clicking on the toolbar button  within the message you 

would like to preview.    If you haven’t done so already, assign one or more recipient groups to the 

message in the dialog window that appears and then click on Preview.

2. On the right of your screen, you will see the entire mail merge message according to how you 
have personalized it for the active recipients on the left side of your screen.    Depending on how many 
user or decision fields you have inserted in to the message, the preview will change as soon as you 
click on a different recipient.

3. Use the following buttons for navigating between the individual recipient records.

Use this button to jump to the first recipient and view the personalized message.

Use this button to view the personalized message for the previous recipient.

Use this button to view the personalized message of the next recipient.

Use this button to jump to the last recipient and view the personalized message.

4. If, in the preview, you determine that the message for a specific recipient has an error or is not what 

you had in mind (e.g. the wrong salutation was used), you can exclude that message from being sent. 

Make sure that the relevant recipient is selected in the list on the left, then disable the button .    The 

recipient will then be shown as inactive (

) when displayed.
5. Once you have ascertained that the message was created correctly for all recipients, you can 

place it in the Outbox by clicking on Send messages .

6. Close the message preview by clicking on the Close button.



Inserting file attachments

Regardless of whether the message is in HTML or plain text format, you can at any time attach a file to 

the mail merge letter.    The file will be stored as an attachment to the message, which the recipient can 

then open.    You can attach any file you wish.    Whether or not the contents will be displayed depends, 

however, on the recipient’s computer and the programs he/she has installed.

Note:    Please be aware that, in contrast to images used in the message, attached files are not placed 

only once on your web server, but are rather a permanent component of each message.    This means 

that if you send a mail merge message to 100 recipients, for example, the attachment will also be sent 

one hundred times.    For very large attachments, this can become a huge burden on your computer.    You 

should be wary of sending large file attachments (approx. 1 MB or larger) for the sake of your recipients. 

If you want to give your customers access to larger files, we recommend you place a link in the download 

area of your website, along with a note stating the associated file size.

How to attach a file to your mail merge message

1. Open the message to you would like to attach a file, and then go to the Format menu and click on 

Insert File.    The File Attachment dialog window will then open.

2. Use the  button to select the directory and file that you want to insert as a file attachment, and 

confirm your choice with Open.    As soon as you have selected a file, it will be shown immediately in 

the file overview along with its size.    Repeat this step if you want to insert additional files.

3. If, in addition, you wish to save the file in another location from its original source (e.g. in the directory 

of your WebMaster MailRoom project), select the corresponding file in the file overview, click on the  

button, and select the desired folder.    Confirm your selection by clicking on the Save button.

4. To remove an exported file from the mail merge message, select it in the file overview and click 

on .    The file will be removed from the message.

5. Once you have selected the desired file, close the dialog window by clicking on Close.

Note:  You can recognize a file attachment in the work area for the mail merge message in question by 

the paper clip symbol at the top right.    You can also call up the File Attachment window by clicking on 

this symbol.



Start window

Each time you open WebMaster MailRoom, the start window will appear, where you can determine 

which WebMaster MailRoom project you want to open.    Select from the following options:

Ÿ Start a new project:  Select this option and click on OK to launch the Start Wizard, which will lead 

you through the most important program settings.

Ÿ Open an existing project:  Select this option and click on OK to continue working on an existing 

project.    Select the project in the Open WebMaster MailRoom Project dialog window that opens.

Ÿ Open the most recently edited project:  Select this option and click on OK to open and continue 

working on the project shown.



Importing recipient addresses

In some cases, the program may be unable to automatically create recipient records.    This usually 

occurs when the recipients themselves did not contact you through an order form or via e-mail.    This 

can be the case, for example, if you want to use WebMaster MailRoom’s mail merge functions to contact 

companies or clients you do not know, in order to send them advertising or information about your 

services.    In such instances, you would have to manually enter every single recipient.

Perhaps you already have a completed address lists in another program, such as in the address book for 

your e-mail program.    WebMaster MailRoom allows you to import contact or address lists from other 

applications, such as Outlook, Access, or Excel.    Naturally, you can also transfer user groups from other 

WebMaster MailRoom projects to the current one.

How to import recipient addresses from other programs

The requirement for importing addresses from other applications is that you have exported the file from 

the corresponding program (e.g. Outlook) as a CSV (table with comma separated values) or a TXT or 

TSV (text file with tab separated values) file.    You can find out how to do this in the corresponding 

application’s manual.

1. To import a recipient group, go to the Recipients and Groups function group and click on the group 

to which you would like to transfer the recipients.

2. Go to the Recipients and Groups menu and select the Import Group/From Other Program entry.

3. The dialog window Import Recipient Addresses will open.    For the file type, indicate whether you 

want to import a CSV or TXT/TSV file, and search for the desired export file.    Confirm your choice 

with Open.    The Import Wizard will then appear.

4. The list shown in the Import Wizard contains the profiles of various export files.    From the list, select 

the profile that corresponds to the export application; otherwise, specify General.    Click on Next.

5. In the next step, you will be required to assign the imported fields to the existing fields in your current 

WebMaster MailRoom project.    This is based on the assumption that the address list you want to 

import uses several or different fields.    By specifying which of the fields should be transferred to which 

WebMaster MailRoom user field, you can for the most part avoid any data loss or errors from 

occurring.

To assign the fields, first go to the window on the left, in which all the specified user fields are listed.    

There, select the first field, E-mail address, by clicking on it then select the corresponding field from 

the window on the right, which contains a collection of the fields from the imported file.    If you click on 

the yellow arrow between the two windows, the two fields will be assigned to each other.    Repeat this 

step for all other fields.

6. While you are performing this task, you may find that the currently defined user fields do not suffice.    

Click on the button Define fields to create new user fields or to edit existing ones.

7. The option underneath allows you to determine if the new recipients should receive messages 

formatted as HTML or plain text.    In addition to a global assignment (all recipients prefer either HTML 

or text), you can – if it exists – specify the field used to determine who receives HTML formatted 

messages for the imported recipient list.



8. Click on the Finish button.    The addresses will then be transferred to the user groups specified in 

your WebMaster MailRoom project.

How to import recipient addresses from other WebMaster MailRoom projects

You can either import all recipients or only selected user groups from other WebMaster MailRoom 

projects.

1. If you want to import all recipient information from another WebMaster MailRoom project, go to the 

Recipients and Groups function group and click on the group to which you would like to transfer all 

of the recipients.    Call up the corresponding project by going to the Recipients and Groups menu 

and selecting the Import Group/From a WebMaster MailRoom Project command.    Confirm with 

OK.    The recipients have now been completely transferred to the specified group.

2. If you only want to import a selected recipient group from another WebMaster MailRoom project, you 

have to first export the group as a CSV file (see note).    Once you have done so, call up the group in 

the current WebMaster MailRoom project into which you would like to insert the new recipients.    Go to 

the Recipients and Groups menu and select the Import Group/From Other Program entry.

Note:

Exporting individual recipient groups 

Go to the Recipients and Groups group and select the group to be exported by clicking on it, and 

then, in the Recipients and Groups menu, select the Export Group/To Other Program entry.    Once 

you have indicated the desired directory in the Export Recipient Addresses dialog window, 

WebMaster MailRoom will save the user group as a CSV file ("comma separated value").

3. In the Import Recipient Addresses dialog window, look for the directory and CSV file in which you 

saved the WebMaster MailRoom recipient group, and confirm your choice with Open.

4. The Import Wizard will then open.    Follow the steps described above in order to assign the user 

addresses and import them.



Inserting decision fields

Decision fields are an extended form of user fields and are also used to personalize mail merge 

messages.

Whereas you employ user fields merely to insert the contents of recipient records, decision fields can 

analyze the content of the text and react by providing different kinds of output.    The information 

contained in the fields is thereby evaluated according to different decision criteria – the decision tree – 

which you have specified.    Insert decision fields whenever a decision needs to be made between various 

words or paragraph elements.    User fields, in contrast, are always definite.

For example:    If you want to write a message to Mr. Miller with the salutation "Dear Mr. Miller", the 

information "Mr." and "Miller" is based on user fields.    "Dear" is, in contrast, a piece of information based 

on a decision field whose evaluation routine has determined that, due to the salutation "Mr.", you are 

dealing with a male recipient, and therefore produces the result "Dear" instead of "Dearest" (if you have, 

for example, defined the salutation "Dear" for men, and "Dearest" for women).    To put it simply, it is 

possible to incorporate user fields into decision fields, meaning, that it is possible to create the salutation 

"Dear Mr. Miller" entirely using decision fields.

Decision fields only function in a meaningful way by evaluating user fields.    It is irrelevant, however, if the 

user field to be evaluated is part of the message or not.    In addition, more than one user field can be 

evaluated within the decision field.    You can find out exactly how to create decision fields using a 

decision tree here.

How to insert a decision field into your mail merge message

In order to insert a decision field into a mail merge message, you first have to have created it in the 

Decision Field Editor.    There are already several predefined salutations included in WebMaster 

MailRoom.

1. Place the cursor at the desired position in the mail merge message.    Go to the Format menu or use 

the context menu, and select Insert Decision Field.    A dialog window with a similar name will open, 

where all existing fields are listed.    Using the mouse, select the one you want to insert, and confirm 

your choice with Insert. 2. As with the user fields, a placeholder will now be inserted in the desired 

position (curly brackets containing the field name).    In the actual message, the information obtained 

through the query criteria in your decision field will take the place of the placeholder.

3. You can also assign a different decision field to a previously inserted placeholder by double-clicking on 

the placeholder, thereby calling up the Insert Decision Field dialog window once again.    In the 

window, select the new field and confirm your choice with Insert.    The old field contents will then be 

replaced.

4. It is particularly important to monitor the actual results when using decision fields.    To do so, use the 

message preview, which you can call up using the  button.    There you can test how the decision 

field reacts to the various types of recipient information for each recipient, and how it changes 

according to the query routine you have provided.

Note:  Inserting decision fields is accomplished more quickly by going to the toolbar in the work area and 

clicking on .    In the pop-up window that opens, select the desired field from the area underneath the 

separator.    You can also use this window to insert user fields.    These are listed above the separator.



5. Several buttons, located to the right of the field overview, are available for the following commands:

Ÿ New field launches the Decision Field Editor, used for creating new decision fields.

Ÿ Edit launches the Decision Field Editor, used for editing the selected decision field.

Ÿ Rename opens a dialog window, where you can rename the selected decision field.

Ÿ Save copy creates a copy of the selected decision field and opens a dialog window in which you 

can specify the name for the copy.

Ÿ Delete, following a confirmation prompt, deletes the decision field in the program.



Creating and editing decision fields

Decision fields function based on queries made to the user fields.    You can create these queries as a 

tree diagram in the Decision Tree Editor.    Depending on how the querying process is designed, the 

results produced in the message will differ.    The functionality of your decision fields is therefore mostly 

dependent on how sensibly you've created your decision tree. 

Laying out decision trees is always based on the same principle:    a logical condition is first assigned to 

the user field.    Depending on whether or not the recipient meets the requirements of certain conditions, 

which are contained in the user field, the corresponding result – namely, the desired text – will be 

outputted.    If a condition is not met, a further query could result, so that the decision tree branches out 

ever more. 

What in theory sounds complicated becomes clearer once you have had the logical structure of the 

Decision Tree Editor explained to you somewhat.

Note:    Because creating a decision tree must be thoroughly thought out and a certain basic 

understanding is required, several fields for various forms of address have been predefined to serve as 

an example.    In order to understand the principle of decision trees, it is helpful to have a quick look at 

how these fields are arranged.

How to create a decision field in the Decision Tree Editor.

1. To get to the Decision Tree Editor, first go to the Format menu and open the dialog window Insert 

Decision Field and click on the New field button there.    The Edit Decision Field dialog window, 

containing the Decision Tree Editor, will then open.

2. A decision tree consists of two components:    first the question, or the query node, in which you define 

the logical condition, and second, the answer, or the output node, which provides the result (in this 

case the text to be outputted).    When creating a new field, the smallest possible decision tree is 

displayed automatically in the Editor window:    a query node (recognizable by the little violet box), 

which branches into two output nodes (recognizable by the little yellow boxes).

3. To edit the nodes, or, in other words, define the node properties, click on the respective box.    You can 

identify selected boxes by their red borders.    Depending on whether you have selected a query or an 

output node, what's shown above will be differ.    While you have the possibility to determine the user 

field to be analyzed and the conditions of the analysis for query nodes, you simply need to enter the 

text to be outputted for output nodes. 

4. In the diagram window, click on the first query node.    You can see two windows above the diagram 

window:    The first one shows all user fields you have created, the other the conditions for 

comparison that will serve as analytical criteria.    Enter the comparison value in the input field on the 

right side (you are using this value to test the corresponding user field).

A query node therefore works on the following principle:    if the field meets the condition, case 1 (=first 

output node) applies, and, if not, case 2 (=second output node) applies.    To assign a query condition 

to the first node, select the user field that refers to the new decision field in the left window.    In the 

second window, indicate in which way (logical condition) the user field should be tested.    In the right 

input field, write the content for which the field should be tested.



Example:    Let’s assume you want to start a mail merge message with "Dear Mr. XY" or "Dearest Ms. 

XY", where XY stands for the last name of the recipient.    Because you want to use a different 

salutation depending on the gender of the recipient, you have to test the user field "salutation" 

(man/woman) in the query node.    The requirement is that the user field "salutation" (man/woman) 

possesses this information.    Therefore, in the first window located on the left, indicate "salutation" as 

the user field.    Use the condition "is equal to" to compare the field with the value "Mr.", which you 

need to enter in the input box.    This means that when the condition "Mr." is met in the user field 

"salutation", the first output node will be inserted and, if the condition is not met, the second one will be 

inserted. [T.N. the example has been somewhat modified since the German referred to using the 

masculine and feminine forms of 'Dear']

5. With the mouse, go to the first output node in order to define what should occur if the first condition of 

the query node is met.    The upper display changes and offers you an input field for the text that will 

be outputted.    You can enhance this text with a user field, which in this case only affects the output 

text of the decision field, but not the query routine itself.    You can add a user field to the text output 

window through dragging and dropping, double-clicking, or with the yellow arrow .

Example:  As long as the condition "Mr." in the user field "salutation" is fulfilled, the mail merge 

message should begin with "Dear Mr. XY".    Add the field "lastname" afterwards from the user field 

window as a placeholder for the actual recipient name ("XY").    Naturally, you could also incorporate 

the salutation ("Mr.") from the user field window in the same way.

6. Now, move the mouse pointer to the second output node in order to define what should occur when 

the condition of the query node is not met.    Proceed in the same way as with the first query node, 

and confirm what you've entered with OK.    Herewith you've created a decision tree with the smallest 

possible scope.

Example:    If the salutation for the recipient is not "Mr.", then the recipient must be female (assuming 

you have only specified these two types of salutations for the user field).    Therefore, in the text field 

for the second output node, write "Dearest Ms." and, afterwards, add the user field "lastname".

Note:  Decision trees are not always as short and concise as in this example.    It can happen very easily 

that, instead of having the second output node, a second condition still needs to be queried.    A query 

node can always lead to further query nodes.    For an example of how various decision fields look, take a 

look at the predefined sample fields for various salutations included in WebMaster MailRoom.

7. You can use the two buttons for query nodes and output nodes in the upper part of the dialog window 

or, with the help of the context menu, accessible by right-clicking, convert an existing field from one 

type to the other.    This has the following important results:

Ÿ If you transform an output node into a query node, another query will be possible instead of the 

second result (in the example, "Dearest Ms."), and therefore a new branch (query node plus two 

output nodes).

Ÿ If you transform a query node into an output node, the tree, after a confirmation prompt, will in 

contrast decrease in size.    Use this method if you want to delete a branch that you have just 

created.

Note:  You can use decision fields for more than incorporating greetings or similar short passages into 



your mail merge messages.    Depending on the information you want to obtain through your forms, you 

can produce entire contents using decision fields.    If, for example, you ask your recipients using fields 

whether they are more interested in cars or motorcycles, you can send them product information on either 

cars or motorcycles, depending on which they indicated.    This way, your clients will only receive 

information that they truly find interesting.



Inserting user fields

With user fields, it's possible to insert recipient-specific information in your mail merge messages in order 

to make them more personal.    You can employ user fields, for example, if you want to start your 

message with "Hello Mr. Miller", instead of the general salutation "Dear Sir/Madam".    The contents of the 

user fields are based on the information provided either automatically by WebMaster MailRoom or by the 

information you specified manually for each recipient.    If you have used an online form on your website 

to create your recipient groups, the user fields will usually be created from the same form fields  the 

recipients were asked to fill out. 

An advanced version of the user field is the so-called decision field, which can be used to insert the 

personal elements through analysis of the user fields in an even more polished way.    The greeting 

formula "Dear Mr. Miller" is, strictly speaking, a combination of user and decision fields:    while the 

decision field determines that we're dealing with a male subject (for this example, let's imagine we want to 

use "Dear" for men and "Dearest" for women"), and not with a female subject, WebMaster MailRoom 

inserts the information from the recipient record into the user field.

The difference between a user field and a decision field is that the one merely inserts information such as 

names and addresses (user field), while the other determines the environment – namely, it checks the 

user field information and reacts according to the contents, thereby "deciding" which information follows 

(decision field).    You can learn more about creating and editing user fields here. 

How to insert a user field into a message

Working with user fields of course requires that you have created such fields and have filled them with 

data.    You can find out how to do this here. 

1. To insert a user field into a mail merge message, position the cursor at the desired spot.    Go to the 

Format menu or use the context menu and select the Insert User Field entry.    The Insert User Field 

window will open, in which all the available user fields are listed.    With the mouse, select the data field 

you want to insert, and confirm your selection by clicking on Insert. 

2. A placeholder (curly brackets containing the field name) will then be inserted into your message at the 

spot you indicated.    In the actual message, the personal information of the respective recipient record 

(e.g. for {lastname}, the name "Miller") will be inserted there.

3. You can also, at a later point, assign a different user field to a placeholder that you have already 

inserted.    To do so, double-click on the placeholder to call up the Insert User Field dialog window.    

Within the window, select the new user field and confirm your selection by clicking on Insert.    The old 

field content will now be replaced by the new one.

4. It is especially important for inexperienced users to monitor the actual text – the one without the 

placeholder.    To do so, use the message preview, which you can call up using the  button.    There 

you can check the content of every field for each recipient, as well as the layout of the fields within the 

body of the message.

Note:  You can insert user fields more quickly if you go directly to the toolbar in the work area and click on 

.    In the pop-up window that opens, select the desired field.    You can use this window to insert 

decision fields at the same time.    They are listed underneath the separator.



Messages view

Before sending your messages from the Outbox (when you don’t have the possibility to call them back 

any more), you have one more opportunity to check over each message.    To do so, display the message 

one more time using the message preview.

1. To call up the message, go to the Outbox work area and ensure that the message you want to display 

is even listed there. 

2. Select the message and click on the  button to view the message.    Alternatively, you can also 

double-click on the e-mail entry.

3. The message preview provides you with information about the recipient address and the subject, 
as well as the message content.    The text is displayed in either HTML or plain text, depending on the 
format in which it was created.

4. You cannot make any changes to the message in the message preview.    In order to make changes, 

select the message and click on the  button to first delete it from the Outbox.    Then go to the 

commands for mail merge messages in the corresponding message, modify the text there, and move it 

again to the Outbox.



Inbox properties

WebMaster MailRoom attaches a note to every message that passes through the Inbox.    This note 

shows you the type of message and all the important details about its status (the message properties), in 

addition to the e-mail address of the sender (or the new recipient).    If an error occurs in the Inbox, you 

will receive a more precise breakdown of the sources of the error.

Call up the dialog window to view the message properties by clicking on the  button, or double-click on 

the relevant message.    Various message boxes will inform you if received the message took place 

normally or if there were errors.    If everything proceeded without any problems, the sender of the 

message is automatically added as a new recipient by WebMaster MailRoom.    If there were errors, you 

have the option of using the Send message button to contact the sender via e-mail.    If you click on the 

button, the message window of your e-mail program (e.g. Outlook) will open.    The address of the sender 

will already be entered there.



Inserting images

Using images in your HTML messages differs functionally from using all other elements that you can 

insert in your WebMaster MailRoom messages.    Characteristically, images (WebMaster MailRoom 

supports the JPG, GIF and BMP graphics formats) are not contained in the actual message, although 

they are displayed there.    They are stored on your web server.    As soon as one of your recipients 

receives your message, their e-mail program will connect to your web server and download the image.

This has a big advantage:    sending the (usually) large image only requires a single data transfer, namely 

from your computer to the web server.    Because the message itself does not contain any images, the 

sending process is sped up.    However, you should still keep in mind the file size of your images:    the 

time required for the recipient to download the image, for the most part, remains the same.    Therefore, it 

is better to use small image files!    500 KB should be the absolute upper limit.

Note:    The transfer of image files to your web server requires that you have entered the correct server 

information in the User Settings in the File menu.

How to insert an image into your HTML message

1. Ensure that the message into which you want to insert the image has been created in HTML format.    

You determine this by whether the HTML  button below the messages work area is activated.

2. Place the cursor at the position you wish to insert the image, and then click on the  button, or 
go to the Format menu and select the Insert Image entry.    The dialog window Insert Image will open.
3. Here, specify the directory and the file name of the image to be inserted.    You can select from 
the usual graphics formats JPG, GIF, and BMP, and use the listbox File type to limit the display of files to 
these types.    As soon as the desired file is shown under File name, click on Open.

4. The Insert Image dialog window will appear, where you can view the selected image in its original 

size.

5. The original dimensions of photos in particular are far too large to be shown in your message.    

Therefore, you have to opportunity, to change the size in increments or decrements of one fifth, using 

the  and 

 buttons.    For larger intervals, you should use the listbox.    Click on OK to confirm your choice.
Note:    Increasing and decreasing the size of an image has an effect on file size.    Therefore, be 

careful if you want to increase an image's size.    Also, note that the size you indicate in this dialog window 
cannot be modified later:    to change the size of an image after you have inserted it, you will have to 
delete it and then insert it again as described here.

6. The selected image will then be shown in the messages work area.    If you click on it, a dotted border 

will appear around it, showing it is selected.    This way, you can then copy the image, cut it out, or 

change its layout.



Inserting tables

In HTML-formatted messages, you have, in addition to the usual formatting styles, the option of inserting 

tables and editing them independently from the rest of the text.    This way you can make the message 

more visually appealing to the recipient.

How to insert a table in an HTML message

1. Ensure that the message in which you want to insert the image has been created in HTML format.    

You determine this by whether the HTML  button below the messages work area is activated. 

2. Place the cursor at the position you wish to insert the table, and then click on the  button, or go 
to the Table menu and select the Insert Table entry.    The dialog window Insert Table will open.
3. Enter the number of columns and rows using the combo boxes, and confirm the information with 
OK; the table will appear in your message.

4. Then enter your text in the individual table cells.

How to edit a table

1. If you determine that the number of columns or rows you initially set is not sufficient, you can at any 

time insert new columns.    To do so, go to the Table menu and select the Insert Column or Insert 

Row entry.

2. Table columns should in most cases be of varying width, depending on their contents.    To increase or 

decrease the size of the table, use the  or 

 buttons.    Place the cursor in the column that you want to change, and click on the corresponding 
button.

3. To delete the table, likewise go to the Table menu.    Select the Delete Table command.

4. Proceed in this manner to also delete individual columns or rows.    The only requirement is that the 

cursor is placed in the region to be deleted.    Then go to the Table menu and select Delete Column or 

Delete Row.

5. If you want to colorize your table, you can either change the background of the entire table or that of 

the individual columns or rows.    To do so, place the cursor in the region to be changed and go to the 

Table menu, select the entry Table Color, Column Color, or Row Color.

6. To find out how to add a border to your table, click here.



Defining table borders

In addition to the normal formatting options for text within the table, you can also define the way the table 

border should look.    You can change the relevant settings in the Table Border dialog window, which you 

can call up by going to the Table menu and selecting the Table Border entry.    Ensure first that the cursor 

is placed within the table.

After calling up the dialog window, you can choose between:

Ÿ No table border (gridlines):    the table is shown without a border.

Ÿ Thin table border:    the table is shown with a fine, non-emphasized border.

Ÿ Strong table border:    the table is shown with a thick, emphasized border.

Note:    The gridlines that are shown when you have selected to have no table border only appear in the 

display area.    By contrast, the recipient will see the table without any borders – and, of course, without 

the gridlines.

Enable one of the option fields and confirm your selection with OK.



Wizard for group assignments

There are various options for changing the way a recipient is assigned to a group.    One of the ways is 

through the dialog window Recipient Properties.    By contrast, the Assignment Wizard makes it 

possible for you to change group assignments not just for individual recipients, but for several recipients 

at once, e.g. to move or delete one or more recipients from a group.

How to use the Assignment Wizard

1. Call up the Assignment Wizard window by clicking on the  button for one of the recipient groups, 

or by going to Recipients and Groups menu and selecting the Group Assignment entry.    Ensure 

first that you have selected a recipient or recipients in the recipient work area whose group 

assignment you wish to change

2. In the middle window (of three), you can find all the recipient groups listed that have been created 
in the current WebMaster MailRoom project.    To add these recipients or the selected recipients to 

another group, select them in the middle window and then click on the  icon above the left window.    
You can also move the selected group(s) by dragging and dropping them.    Similarly, you can also delete 
these or selected recipients from individual groups.    In this case, use the 

 icon located above the right window, or drag and drop to move the relevant group(s).

3. If you don't want to move these or selected recipients to another user group but rather want to place 

them on the blacklist, thereby preventing them from receiving any more messages, click on the 

Assign selected recipients to the blacklist option field at the bottom.

4. In the listbox Preferred e-mail format, you then have the option to retain the mail format specified in 

the recipient properties for the selected recipients, or to assign them new properties (HTML or text).

5. Confirm your choices with OK.

Note:    You can select multiple recipients within a group by holding down the [Shift] key and using the 

arrow keys.    You can use the keyboard shortcut [Ctrl]+[A] to select all the recipients in a group.



Inserting a Web link

You will probably want to place a link within your mail merge message, e.g. to your website.    In HTML-

formatted messages, you can create a link using the Insert External Link window, where you can insert 

any text you wish to lead not only to an Internet address, but can also to an e-mail address (when the 

recipient clicks on the latter link, the message window of the e-mail program automatically opens).

Note:  The option of using any text as a link is not available if you are creating your message in plain text. 

There you can merely enter valid Internet addresses in the form of "www.youraddress.com" as a Web 

link.    To insert an e-mail link in a text message, the e-mail address needs to contain "mailto:" in front of it: 

"mailto:name@address.com".

How to insert an external link into an HTML message

There are two ways of inserting a Web link into an HTML message:    you can either insert the entire valid 

Internet address (URL), or you can assign a destination link to any desired word, without the URL being 

displayed.

1. To insert a simple Internet address as a link in your mail merge message, place the cursor at the 

position in your message where the URL should appear, and open the dialog window Insert External 

Link by clicking on the  icon.    Alternatively, you can also go to the Insert Web Link entry in the 

Format menu.

Enter the valid Internet address in the URL text box (e.g. "www.databecker.com") and confirm 
with OK.    The address will then be inserted at the specified position.    The way it's underlined and 
highlighted makes it recognizable as a Web link.

2. To link any desired word in your mail merge message to an Internet address, you must first select the 

word in the messages window using the mouse.    Then click on the  icon and enter the desired 

Internet address in the URL text box.    After confirming your entry by clicking on OK, the selected word 

will have the target link assigned to it.    Here, too, there is evidence that the word is a Web link – 

recognizable by the underlining and how it's highlighted.    Naturally, you can in the same way 

transform multiple words – even an entire paragraph, in theory – into a Web link.

3. When you enter a URL, you can immediately check the destination link by clicking on the Display 

button.    Your Internet browser will then open and display the website you have specified, assuming 

the address is correct.

4. To insert an e-mail link, which will automatically open the message window of the e-mail program, click 

on the button Create e-mail link and, in the dialog window that opens, enter the desired e-mail 

address.    This will be entered into the URL window, supplemented with the command "mailto:".    

Confirm the entry with OK.

Note:  Notice that within WebMaster MailRoom, the links to websites as well as the ones for e-mail are 

not functional.    These will function once the message has been sent, or, more precisely, when the 

recipient receives it.    The same goes for Web links created in plain text format:    even if you specify the 

URL or mailto links manually, these links will only become active once the recipient receives the message.



Form Wizard

WebMaster MailRoom analyzes all of the incoming messages from your online forms according to the 

field information contained within and then, where applicable, automatically stores the information into the 

predefined recipient records.    For this automatic recipient analysis to complete successfully, it is 

necessary that your forms were also created in WebMaster MailRoom, so that there is a link between the 

form, its user fields and the analysis program.

You can create forms for ordering or canceling subscriptions using the Form Wizard.    There, you can 

decide in which format the form should be created:    as an HTML form, which you can incorporate into 

HTML projects (e.g. your existing website) or as web to date form, which you can conveniently insert into 

existing web to date projects, and which can be edited later.

Note:    web to date is a desktop-based CMS (Content Management System) from DATA BECKER, which 

you can use as an aid, even without HTML knowledge, to create professional websites and update or 

reorganize them with ease.    You can find out more about web to date at Fehler! Textmarke nicht 

definiert..

Creating order forms with WebMaster MailRoom

1. Call up the Form Wizard from the File menu by selecting the Create Order / Cancellation Form entry. 

Make sure that the Order form option is selected.

2. Normally, only one of the predetermined subscriptions can be ordered or cancelled using a form.    By 

selecting the control box Recipient is given the option to subscribe, you are allowing the recipient 

to choose which subscription (newsletter, help wanted ad, etc.) he/she wants to receive.    In the 

finished form, the individual mailing groups will then be displayed as control boxes that can be 

enabled. 

3. Click on Next in order to enter, in the dialog window that follows, which recipient information you want 

to obtain via your online form, i.e. which user fields should be inserted into the form.    Select the 

desired fields by enabling the corresponding control boxes.    All of the fields you have created in the 

current WebMaster MailRoom project are listed in the overview.    Should you determine that the fields 

that are currently available are not enough to acquire the desired information while you are in the 

middle or creating the form, you will first have to go to Recipients and Groups to create a new user-

defined field, so that it will be available in the overview.

Note:    Do one or more of the user fields created by you seem to be missing in the overview?    The 

reason for this could be that you haven't specified an abbreviation under Field Properties.    Even if 

the field abbreviation isn't displayed on the website and is used only for internal management, it is 

absolutely necessary for smooth communication between WebMaster MailRoom and your form.    Go 

back and specify an abbreviation in the Field Properties window.

4. After selecting the user fields to be used in the form, go to the next dialog window by clicking on Next 

in order to determine which subscription can be ordered via the form.    In this list, too, all the 

subscription groups for which you have specified an abbreviation are listed.    You can use the form to 

allow subscriptions to all groups, or to only a particular group.    Select the groups to which your clients 

can subscribe from the overview by clicking on them.

Note:    If at the beginning of the Form Wizard you selected the option Recipient is given the option 



to subscribe, you don't only need to specify one or all groups; you can specify any number of 

subscription groups.    The groups will then be made available in the finished form for the visitor to 

select from.

5. Under Format, you can specify in the appropriate field whether the interested visitor can select the e-

mail format.    In this case, an option will be included in the finished form that allows the visitor to select 

the message format as either HTML or text.    With the two other listbox entries, you    can 

predetermine the e-mail format.    Confirm your choices once again with Next.

6. In the next step, determine the format in which the order form should be created.    As previously 

mentioned, there are two choices here.

Creating the form in web to date format and incorporating it into a web to date project:

If you have created your website using web to date from DATA BECKER, the easiest way to proceed 

is to insert the WebMaster MailRoom form into it.    The form will then be saved as a W2F file, readable 

by web to date, and then incorporated into the open web to date project as a form paragraph.

Ÿ To create a W2F file and thereby a web to date form, enable the option Save as web to date form 

and then click on the Finish button.    In the dialog window Save Form As, you can determine the 

save name and location in which the web to date form should reside.    Here, select, for example, 

the project folder of your web to date website, and then confirm your choice with Save.

Ÿ To incorporate your form into your web to date project, go to the main page or to the subpage on 

which your form should appear.    Create a new paragraph and select the Form paragraph type.    

As soon as you click on OK, the dialog window New Form will open.    Here you will now see the 

option Incorporate WebMaster MailRoom form, which you need to select.    By clicking on Finish, 

the Open Form window will appear.    If you now specify where you've saved the W2F file (see 

above) and click on Open, the form you've created in WebMaster MailRoom, complete with all its 

user fields, will then be insert as a web to date form paragraph in the current main page or 

subpage.    You do have the option of further editing your form in web to date, but, even though it 

interacts smoothly with WebMaster MailRoom, it is not recommended

Creating the form in HTML format:

You can incorporate an HTML-formatted form into any website.    To do so, click on the Create HTML 

form option.    In addition, indicate the server to be used for sending the form information or the script 

to be used.

Sending forms using the WebMaster MailRoom Form Service (recommended)

If you select this service from WebMaster MailRoom, all sent forms will be routed through the 

WebMaster MailRoom server.    WebMaster MailRoom's form script will be used for this.    This is the 

preset option and the recommended method for most users.    The only time you shouldn't select this 

option is if you are using your own server or you want to use your own form script.

Click on Next and, in the first text box of the dialog window that appears, specify the e-mail address to 

which you want to send the form data.    In the lower text box, enter the webpage that should appear as 

soon as the visitor to your site has sent the form.    This can be the start page of your website.    It is 

preferable, however, to create a dedicated confirmation page for your website that informs the user 



that the subscription has been submitted (e.g. "Thank you very much for your order").

Sending forms via another server (only for advanced users)

Just because your provider provides space on his server doesn't necessarily mean that that server is 

also equipped to handle incoming form data correctly.    Therefore, you should be certain that the 

server you specify here truly is a so-called active server.    If that's the case, you can copy WebMaster 

MailRoom's form script to the server.    You can find scripts for various server types on the WebMaster 

MailRoom CD.

Click on the second option if you want the form contents to be processed by your own server, and then 

on Next.    In the dialog window that follows, you have to enter the Internet address in the Mail 

Gateway URL field of the form script to which all the form data should be sent, in addition to the 

specifications described above.

Using your own form scripts (for advanced users only)

If you are experienced enough to set up your own scripts, enter the necessary information in the dialog 

window that appears by clicking on the third option:

Mail Gateway URL Defines the ACTION property, i.e. the address to which the form data should be 

sent.

Method Defines the METHOD property of the form.    The values POST or GET are 

allowed.    The W3 consortium recommends the GET method, if the program 

used for analyzing the data only requires the data as a functional parameter.    

The POST method is recommended for all situations where the program 

performing the analysis will undergo further operations such as inserting the 

data into a database.    In addition, POST is better suited for larger amounts of 

data than GET, for which the parameters are appended to the URL.    Generally, 

you should use the POST method.

Encoding Defines the ENCTYPE properties of the form.    Possible values are 

application/x-www-form-urlencoded, text/plain und multipart/form-data.    

Generally, you should use application/x-www-form-urlencoded.

The following settings are possible for Additional form field script information:

E-mail address If you have to tell your script the e-mail address to which the message should 

be sent using a <input type="hidden"> tag, you can enter the name and the 

value of the tag here.    You can find out more from the documentation that 

comes with your script.

Subject Specify in this field the subject with which the script you are using is going to 

send the e-mail.

Confirmation URL Many scripts allow a confirmation page to be displayed (or to which the user is 

redirected) after sending the e-mail.    If this parameter is controlled by a tag, 

enter its name and value here.

Once you have decided upon one of the three methods and you have entered the necessary 

information, the only thing you need to do is format the HTML document.    When doing so, you should 

make sure that the form visually fits into your existing website.    Select the Font that you are using on 



all the other pages, and decide if you want to use Bold headings.    Under Form color, select a 

background color.    This, too, should correspond with all the other backgrounds.    With Element color, 

you can assign a color to the user fields.    Here, you can also choose the same color as the form.    

Use Font color to determine the color of the fields and headings.    Although you can assess your 

choices in the Preview window, you have the option of assessing the complete form in HTML view – 

including all user fields – by clicking the Display form button.

Click on Finish to save the form as an HTML document under a name and directory you have 

specified.    You can use the HTML editor with which you created your website to incorporate the 

document or the HTML source code into any given website.

Creating cancellation forms with WebMaster MailRoom

Creating cancellation forms is almost identical to creating order forms.    The only difference is that the 

option to choose user fields is missing for cancellations.    The reason for this is:    when canceling (e.g. 

newsletter subscriptions), the interested party no longer needs to provide any information, but merely 

needs to make the cancellation known.

To create a cancellation form, proceed in the same manner as described for order forms.



Creating and editing text blocks

Depending on the type of mail merge messages you're creating, its purpose and its make-up, certain 

phrases, sentences or entire paragraphs can often repeat themselves.    If you’re distributing a monthly 

newsletter, every issue should, for example, conclude with a masthead or a note on how to unsubscribe. 

So that you don't have to enter these text passages anew each time, WebMaster MailRoom offers you the 

option of creating permanent text blocks, which are independent of the message and can be inserted at 

any point.

Note:    You are saving text within a text block.    Text blocks are always created globally for the entire 

WebMaster MailRoom project.    Therefore, it is completely irrelevant in which mail merge message you 

create the text block:    they are also available for every other message.

How to create new text blocks and edit existing ones

1. Go to any mail merge message and then to the Format menu or the context menu and select the Text 

Blocks entry there.    Alternatively, you can also press the [F3] key.    The Text Blocks dialog window 

will open.

2. The Text Blocks dialog window is divided into two areas:    an upper overview window, in which all the 

text blocks that have been created so far are listed, and a lower preview window, which displays the 

text block selected above in its entirety.

3. To create a new text block, click on the New button and write the desired text in the text entry area in 

the Create New Text Block window that appears.    To access the text block more quickly later on, you 

can define a shortcut key in the corresponding listbox, which you can use to conveniently select the 

text block.    You can choose from the letters A to Z.    Normally, the shortcuts are assigned 

successively.    Confirm your entries by clicking on OK.

4. The new text block will then be listed in the overview window.

5. Naturally, with the exception of the assigned shortcut key, you can change any text block at any time.    

To do so, select the block you want to change in the overview window and click on the Edit button.    

Make the changes in the Edit Text Block dialog window and then click on OK to accept the altered 

content.

6. If you want to remove outdated text blocks from the list, select the desired entry and simply click on the 

Delete button.    The text block will then be immediately removed from the list.

Note:  You can also define a text passage after you have created it in a mail merge message as a text 

block.    To do so, select the desired part of the passage in the work area of your mail merge message 

and, as described above, open the Text Blocks dialog window.    If you then click on New, the selected 

passage will already be inserted.    All you have to do now is define a shortcut key and click on OK to 

create the new text block.    Note that proceeding in this way, however, causes all formatting of the 

selected passage to be lost.

How to insert a text block in a message

1. To insert a text block into a message, first place the cursor at the position you want the saved text 

passage to appear.    Then use the [F3] key, or the Text Blocks entry in the Format menu or the 

context menu, to call up the text block overview.



2. You can insert the text block by selecting the entry and then clicking on the Insert button.    It's faster, 

though, to hit the letter of the shortcut key assigned to the block.

3. The text passage is then inserted into the mail merge message and, if necessary, can be further edited 

as you would normal text.

Loading and saving text blocks

If you have created several WebMaster MailRoom projects, you can exchange any of the text blocks 

between the various projects.    To import the data, you will first have to have saved it as an M2T file.    

Use the Save as button to convert the text block to this file format, and then specify where you want to 

save it.

To use a text block from another project in your current WebMaster MailRoom project, click on the Load 

from button and, in the window that opens, specify where you saved the M2T file.    As soon as you click 

on Open to confirm your choice, the text blocks contained in the M2T file will be added to the current 

project.



Delayed sending

If you have enabled the control box for delayed sending in the user settings under Send options, and 

you indicated a specific time – perhaps because the computer isn't in use as much then – the messages 

placed in the Outbox will not be sent immediately to the e-mail server but rather at the scheduled time.

If you click on the Send button  in the Outbox prior to this time, the Delayed Sending window will 

open.    It will provide you with information about the scheduled (as indicated by you) as well as the 

current send time/date.

You can remove the delay by clicking on Send now.    The message selected in the Outbox will then be 

sent immediately.



Start Wizard step "Start"

If you indicate that you want to open a new WebMaster MailRoom project in the Start window, the Start 

Wizard will automatically start.    Its task, over several steps, is to query you on important information for 

WebMaster MailRoom's functionality, including information about your e-mail address or the server.    You 

can change the settings you undertake here at a later time while you are working on a project.

When the Start Wizard appears, you are first asked to supply information about the sender.    In the first 

text box, Sender's e-mail address, enter the e-mail address that should appear to the recipients i.e. the 

one that your clients should see.    This is normally your e-mail address or that of your company.

For Sender (name), specify the name that should appear to your recipients or clients as the sender.    

This can be, aside from your own name, also the name of your company, or a keyword (e.g. "newsletter").

You can change what you've entered here any time by going to the File menu and selecting User 

Settings/E-mail Server.

Confirm your entries with Next to continue on to the next window in the Start Wizard.



Start Wizard step "SMTP server"

In the SMTP server address text box, enter your SMTP address, or your outgoing mail server address.    

The outgoing mail server accepts the messages sent from WebMaster MailRoom and forwards them to 

the specified recipients.    You can find out your SMTP address from your provider or your server 

administrator.

You can change what you've entered here any time by going to the File menu and selecting User 

Settings/E-mail Server.

Confirm your entries with Next to continue on to the next window in the Start Wizard.



Start Wizard step "Use subscriptions"

One of WebMaster's special features is its ability to automatically analyze all incoming orders and 

cancellations for your subscriptions (e.g. newsletters).    This way, recipient records for new 

prospects/customers will be created (or deleted, in the case of a cancellation), without your needing to do 

anything.

You can set up WebMaster MailRoom in such a way that you merely need to use the program for creating 

and sending mail merge messages.    It makes even more sense to also make use of the automatic 

management of Inboxes at the same time.    This way, all e-mail that is associated with a particular 

subscription won't be downloaded by your default e-mail program but instead by WebMaster MailRoom 

and displayed as new messages in the Inbox work area.    The automatic process described above will 

take place at the same time.

The automatic management of your Inboxes has two requirements:    one, that the incoming e-mails meet 

the requirements for being received via WebMaster MailRoom    , and two, that you've specified the 

correct address for you incoming mail server – the so-called POP3 server.    Without this information, 

WebMaster MailRoom is unable to receive mail.

If you want to receive e-mail regarding your subscriptions using WebMaster MailRoom, thereby making 

use of the automatic management for creating and managing recipient information, then enable the option 

Yes, use newsletter subscription.    In the next step, you can then enter the address of your 

POP3/incoming mail server.    If you don't want to use WebMaster MailRoom for receiving messages, 

choose the second option.

Confirm your entries with Next to continue on to the next window in the Start Wizard.



Start Wizard step "POP3 server"

If in the previous step you decided upon using the automatic management of incoming mail in WebMaster 

MailRoom, you will now have to enter the address of your POP3/incoming mail server.    The POP3 server 

accepts all the messages from your recipients or customers and forwards them to the e-mail address you 

indicated, where they are downloaded by WebMaster MailRoom and automatically analyzed.    Fill in the 

following fields:

POP3 server address:    Here, enter the POP3 address, or the address of your incoming mail server.    

You can obtain this from your provider or server administrator.

Account name:    Here, enter the name of the POP3 mail account that was set up on your incoming mail 

server.    Your server administrator or provider can perform setting up such an account.    Ask your provider 

or administrator for the name.

Password:    Here, enter the password for your POP3 account.    This was provided by your provider, or 

you selected it yourself.    For security reasons, only stars (*) will be displayed on the screen.

You can change what you've entered here any time by going to the File menu and selecting User 

Settings/E-mail Server.    By entering a POP3 address, you are automatically selecting the option of 

receiving all subscription related mail (orders or cancellations) using WebMaster MailRoom.

Confirm your entries with Next to continue on to the next window in the Start Wizard.



Start Wizard step "Use images"

If you want the mail merge messages you have created in WebMaster MailRoom to contain images, the 

images will not be sent via e-mail in the outgoing messages, but instead stored once on your web server. 

As soon as the recipient opens your e-mail message, the e-mail program will automatically download the 

image from the web server.    Proceeding in this way has the huge advantage that the image only needs 

to be sent once – namely, to your WWW server – and does not need to be sent individually for each e-

mail.    This saves a noticeable amount of time and money, in particular for extensive e-mail activity.

With the help of the two options, decide if you want to use images or not.    If you select the first option, 

Yes, I want to use images, you will have to enter the login information for the server on which you want 

to store the images in the next step.

Confirm your entries with Next to continue on to the next window in the Start Wizard.



Start Wizard step "WWW server"

If in the previous step you decided to use images in your mail merge messages, you will now need to 

enter the address of your web server.    You will need to store all images on your web server, from where 

they are automatically downloaded by the recipient's e-mail program.    Fill in the following fields:

WWW address:    Here, enter the WWW address of the web server where your website resides (e.g. 

"www.yourwebsite.com").    If you want to store your image files in a particular directory, expand the 

address by entering the corresponding directory (e.g. "www.yourwebsite.com/images").

FTP server name:    Here, enter the name of your FTP server.    You can obtain this information from your 

provider or server administrator.

FTP username:    Here, enter the username for your FTP server.    You can obtain this information from 

your provider or server administrator.

FTP password:    Here, enter the access password for your FTP server.    This was provided by your 

provider, or you selected it yourself.    For security reasons, only stars (*) will be displayed on the screen.

You can change what you've entered here any time by going to the File menu and selecting User 

Settings/Web Server.    By entering a web server address, you are automatically selecting the option of 

including images in your messages.

Confirm your entries with Next to continue on to the next window in the Start Wizard.



Start Wizard step "Create user fields"

By creating user fields, you have the option of individualizing mail merge messages to make them 

recipient-specific.    You can employ user fields to manage all personal data, such as gender, name or 

address of the recipient.    By inserting user fields into your messages, you are giving them a human 

touch.

In this step, indicate if you want sample user fields, such as salutations and the first and last names of the 

recipient, to be automatically created for the new WebMaster MailRoom project.    You can at a later time 

always alter or delete these fields and, of course, add more fields easily enough.

To create sample fields (recommended), enable the option Yes, please create sample fields.

Confirm your entries with Next to continue on to the last window in the Start Wizard.



Start Wizard step "Create groups"

User groups refer to the subscriptions that you are managing in your WebMaster MailRoom project (e.g. 

newsletters for various topic-related groups).    Therefore, your recipients should be assigned to at least 

one user of recipient group.    In each WebMaster MailRoom project, you have the option of creating 

various parallel recipient groups, which allows you to manage various subscriptions concurrently.

As with user fields, you can also automatically create new sample groups when starting a new project.    

These are the groups "Standard" (recipients who have ordered a simple subscription), and "Premium" 

(recipients who will receive extensive mail merge messages, or ones who have paid for a newsletter or 

made contributions).    Be aware that in both cases empty groups will be created; the sample groups will 

not contain any recipient records.

Even if these two groups don't exactly meet your requirements, it is particularly recommended for users 

who are new to WebMaster MailRoom to create sample groups so that they can acquire an 

understanding of using subscriptions.    Naturally, you can delete both of these groups at a later time, or 

replace them with your own group, and, of course, also add more groups with ease.

After you have decided for or against creating sample groups by selecting an option, you can close the 

Start Wizard by clicking on the Finish button.    In the dialog window that then opens, New WebMaster 

MailRoom Project, determine a save location and, under File name, enter a name for the project.

Confirm the information you've entered by clicking on Save.    Your new WebMaster MailRoom project has 

now been created.



Inserting an unsubscribe link

Regardless of the newsletter you are sending out, you should always give your recipients the option of 

canceling their subscription.    You can either organize the canceling of subscriptions using a special 

cancellation form, which you have created using the Form Wizard in WebMaster MailRoom and have 

incorporated into your website, or you can deal with cancellations via e-mail:    your recipient sends you 

an e-mail, whose heading meets the subject entry requirements for WebMaster MailRoom on the one 

hand, and, at the same time, also contains the necessary information for the automatic subscription 

management of WebMaster MailRoom to recognize it as a cancellation (as opposed to an order).

Because it's not possible to prevent the recipient from making a mistake when entering the information in 

the subject line, it is recommended to insert a Cancellation Link in every newsletter (assuming it's been 

created in HTML format).    Doing so automatically inserts an e-mail link with the format "mailto:".    The 

message window, which will automatically be opened by the recipient's e-mail program when he/she 

clicks on the link, will already contain all the necessary information for canceling the corresponding 

subscription in the subject line.

How to insert a cancellation link in your message

1. To insert a cancellation link in your message, first ensure that the relevant message is being displayed 

in the work area of your mail merge messages.    Place the cursor at the desired position (e.g. the end 

of the message).

2. Go to the Format menu or, by right-clicking, open the context menu, and select the entry Insert 

Unsubscribe Link.    The corresponding dialog window will open.

3. Within the tabular overview, select the subscription group which should be cancelled using the 

unsubscribe link.    This should generally be the group you've actually assigned to the current mail 

merge message.

4. In the lower text box, the address to which the cancellation e-mail should be sent is shown – it is the 

same as the one you specified under E-mail Server in the user settings, and thus usually your own.    

Change the entry to define a new recipient address, and then click on OK.

5. For HTML e-mails, WebMaster MailRoom automatically inserts the text "Click here to unsubscribe from 

this newsletter" at the point where you inserted the unsubscribe link; the word "here" is created as a 

link.    You can, of course, change the text at any time.

The following passage is inserted in e-mails formatted in plain text: "You don't want to receive any 

more e-mails?    Send an e-mail with the subject "unsubscribe group name" to user@address.com", 

where the name of the subscription as well as the e-mail address are automatically inserted by the 

program.



Design Wizard

Using the Design Wizard, you can design the headers you use in HTML-formatted messages in various 

ways.    This way, your newsletters will have an unmistakable, unique character.    From classical to 

modern, with or without graphics – WebMaster MailRoom offers you a wide variety of designs.    Every 

design exists in various, sequentially determined, color combinations, which can, however, be changed at 

any time.    The requirement for using the designs is the same as for all design options in e-mails:    the 

message has to be created in HTML.

Note:    Designs inserted in the message and created in the Wizard are saved as a graphic, or, more 

precisely, a GIF file.    WebMaster MailRoom manages these much like every other image:    the designs 

are not sent directly to the recipient, but are stored once on your web server.

How to use the Design Wizard

1. To incorporate a design in an existing mail merge message, ensure that the message is being 

displayed in the work area.    Call up the Design Wizard by going to the Format menu, or using the 

context menu, and selecting the entry Use Design.    The Design Wizard window will then appear.

2. In the text boxes Heading and Slogan, enter the text for your message header.    Make sure your 

heading is something precise and clear, such as the title of the newsletter; for the slogan, include 

some secondary information, such as the circulation number or the topic.    You can see what you've 

entered in the preview window below.

3. You then have to assign a design to your heading.    To do so, pick one of the predefined variations.    In 

the Design window, click through the various types, then verify the result in the preview window.

4. Various color combinations are shown in the Color palette window.    See how they look with the 

design you have chosen.

5. If you would like to use colors other than the ones given here, click below the Color palette window on 

the User-defined entry.    You then have the option of changing the individual components of the 

design, using the five fields on the left. [T.N. Should be right?] In addition to the font colors for the 

slogan and heading, you can also adjust the colors of the two design elements (Logo A and Logo B).    

In addition, you can also determine the color of the HTML e-mail here.    You can see all changes 

you've made in the preview window.

6. Once you've created a design you are happy with, click on OK.    It will then be placed in your HTML 

message.    There you can move the design, center it, or place it anywhere you want in the usual way.




